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Copyright

  1996 SyQuest Technology. All rights reserved.

This document and all material contained in it are copyrighted. The 
document may not be copied, in whole or in part, without the 
written consent of SyQuest Technology.

Credits

IBM, PC-AT, and PS/2 are registered trademarks of International 
Business Machines, Inc.

Macintosh is a registered trademark of Apple Computer, Inc.

MS-DOS is a registered trademark of Microsoft Corporation.

SyQuest is a registered trademark of SyQuest Technology, Inc.

All other brand and product names are trademarks or registered 
trademarks of their respective holders.

Disclaimer

SyQuest Technology makes no warranty of any kind with regard to 
this material, including, but not limited to, implied warranties of 
merchantability and fitness for a particular purpose. SyQuest 
Technology shall not be liable for errors contained in this document 
or for incidental or consequential damages in connection with the 
furnishing, performance, or use of this information.

The information contained in this document is subject to change 
without notice. The contents of this document may be revised 
without prior notice.

SyQuest Technology also reserves the right to make changes and/or 
improvements to its products without incurring any obligation to 
incorporate such changes or improvements in units previously sold 
or shipped.

Technical Data Restrictions

In the case of sale to or use of units by the Department of Defense, 
use, duplication, or disclosure of any software, firmware, or related 
documentation is subject to restrictions stated in paragraph (c) (1) 
(ii) of the “Rights in Technical Data and Computer Software” clause 
at DFAR 252 227-7013.



             
For civilian agencies, use, reproduction, or disclosure of the software 
and related documentation is subject to restrictions set forth in FAR 
52.227-19. Unpublished rights are reserved under the copyright laws 
of the United States.

FCC Warning

This equipment generates and uses radio frequency energy and, if 
not installed and used properly, that is, in strict accordance with the 
manufacturer’s instructions, may cause interference to radio and 
television reception. It has been type-tested and found to comply 
with the limits for a Class B computing device in accordance with 
the specifications in Subpart J of Part 15 of FCC Rules, which are 
designed to provide reasonable protection against interference in a 
residential installation. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause interference to radio or television reception, 
which can be determined by turning the equipment off and on, try 
to correct the interference by one or more of the following 
measures: 

• Reorient the antenna

• Relocate the equipment with respect to the receiver

• Move the equipment away from the receiver

• Plug the equipment into a different outlet so that equipment and 
receiver are on different branch circuits

If necessary, consult your dealer or an experienced radio/television 
technician for additional suggestions. The booklet entitled How to 
Identify and Resolve Radio-TV Interference Problems, prepared by 
the Federal Communications Commission, may be helpful. This 
booklet, Stock No. 004-000-003454, is available from the U. S. 
Government Printing Office, Washington, DC 20402.



                          
Safety Standards

This product meets the following national and international 
regulations:

• UL 1950 Standard for Safety of Information Processing and 
Business Equipment

• UL Standard for Safety of Information Technology

• CSA C22.2 No. 154 Data Processing Equipment

• CSA C22 No. 220 Information Processing Equipment

• IEC 435 Safety Requirements for Data Processing Equipment

• IEC 380 Safety of Electrical Energized Office Equipment

• IEC 950 Safety of Information Technology Equipment in Electrical 
Business Equipment

• VDE 0871/1984

• VFG 243/1991

Inquiries

While every effort has been made to ensure that the information 
provided herein is correct, please notify us in the event of any errors. 
Mail comments about this document to SyQuest Technology, 
Technical Publications, 47071 Bayside Parkway, Fremont, CA 94538. 
Please include your name, address, and telephone number, and the 
title and part number and revision of the document.

Document History

The table below lists changes issued for this EZFlyer Installation 
Guide.

Date Release Part Number Revision Revised by

May, 1996 Release 1 110333-001 Revision A Manual 3, Inc.



                    
Support, Documentation and Repair
For detailed information about SyQuest® drives, cartridges, and software, 
refer to the online documentation on the diskette labeled SyQuest® 
Installation Diskette-1. To print or interactively view the online 
documentation, insert the diskette labeled SyQuest® Installation Diskette-1 
into a diskette drive and run the MANUAL program.

SyQuest® Technology 47071 Bayside Parkway Fremont, CA 94538-6517 510-226-4000

Sales

U.S. Voice: 1-800-245-CART
Email: sales@syquest.com

Japan Voice: +81-3-5820-2601
Fax: +81-3-5820-2602

Australia Voice: +61-2-369-5773
Fax: +61-2-369-2461

Netherlands Voice: +31-23-5693333
Fax: +31-23-5693339

France Voice: +33-1-471-29-191
Fax: +33-1-471-29-266

Singapore Voice: +65-294-8484
Fax: +65-294-7277

Germany Voice: +49-711-900-760
Fax: +49-711-900-7629

U.K. Voice: +44-1-313-392-022
Fax: +44-1-313-396-765

Scotland Voice: +44-1-313392022
Fax: +44-1-313396765

Italy Voice:+39-49-9500964
Fax: +39-49-9500963

Technical Assistance

FTP
World Wide Web

ftp://ftp.syquest.com
http://www.syquest.com

Australia Voice: +61-2-369-5773
Fax: +61-2-369-2461

Email support@syquest.com
support-mac@syquest.com
support-pc@syquest.com

Europe Voice: +31-23-5693333
Fax: +31-23-5693388
BBS: +31-23-569-3381



 

U.S. and Canada
Monday - Friday
Saturdays & Holidays
Sundays

1-510-226-5400
5 a.m. - 7 p.m. Pacific Time
7 a.m. - 5 p.m. Pacific Time
8 a.m. - 4 p.m. Pacific Time

Japan Voice: +81-3-5820-2601
Fax: +81-3-5820-2602

Singapore Voice: +65-294-8484
Fax: +65-294-7277
Part Number 110333-001 Revision A

Fax
BBS

1-510-226-4110
1-510-656-0473

UK/Scotland Voice: +44-131-338-0102
Fax: +44-1-131-396-765



                         
Getting Started
1. Unpack your EZFlyer ™  drive.

Unpack and inspect the contents of the shipping carton. 

Note: The online manual provides advanced configuration information. 
To view the online manual, insert SyQuest® Installation Diskette-1 into a 
diskette drive and run the MANUAL program (manual.bat).

Note: If you are upgrading from an EZ135 drive to an EZFlyer™  drive, 
follow the upgrade instructions in Appendix A on page 13 before 
installing your EZFlyer™  drive.
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2. Study the drive’s features, controls, and indicators.
Once you are familiar with your EZFlyer™  drive, go to “Installing the 
Hardware” on page 4.

Caution: SyQuest® strongly recommends that you operate your EZFlyer™  in 
the horizontal position, as shown throughout this guide. If you must use the 
EZFlyer™  in the vertical position, be sure to securely support your EZFlyer™ 

 on both sides to prevent the drive from falling over.

Caution: Never store or transport the EZFlyer™  with the cartridge partially 
inserted. Leaving a cartridge partially inserted, or transporting the EZFlyer™  
with the cartridge inserted may damage the EZFlyer™  drive and void your 
warranty.

Note: The EZFlyer™  drive automatically goes into a power saving mode 
after 5 minutes of inactivity. In the power saving mode, the Drive Activity 

®
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LED is off. Normal drive activity will restore full power to the drive when 
needed.
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Installing the Hardware
1. Turn off your computer.

2. Locate your computer’s parallel port.
Your computer’s parallel (printer) port connector may be mounted either 
vertically or horizontally. Your printer (if you have one) is normally 
attached to the parallel port.

3. Plug the 25-pin connector end of the cable into your 
computer’s parallel port.
If you currently have a printer cable attached to this port, remove the 
printer cable first.

Caution: Many SCSI adapters also use 25-pin connectors. Do not attach 
your EZFlyer™  Parallel Port drive to a 25-pin SCSI connector, or you may 
damage your drive. Use only the SyQuest-provided parallel port cable. Data 
errors may occur if you use a different cable.

1 2

Computer
 Possible Locations of your 
Computer’s 25-pin Parallel Port

1 2

Tighten Screws
to Secure Connection

25-pin Connector End
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4. Plug the 25-pin receiver end of the cable into the left-
hand EZFlyer ™  Parallel Port connector.

5. Connect your printer to the EZFlyer ™  drive’s printer 
connector.
If you removed a printer cable in step 3, attach the printer cable to the 
connector labeled To Printer. 

6. Plug the provided power adapter into the DC power 
connector located on the rear of the EZFlyer ™  drive. 

Caution: Only use the EZ family power adapter. Using a different power 
adapter may damage your drive. 

From Computer To Printer

From Computer

Tighten Screws
to Secure Connection

25-pin Receiver End

EZFlyer™ Parallel Port Connector

From Computer To Printer

To Computer Tighten Screws
to Secure Connection

To Printer

DC Power Connector
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7. Plug the power adapter into an AC power outlet.

Caution: Verify that the power adapter is compatible with your AC power 
outlet.

8. Turn on your drive and your computer.
Verify that the Power On LED glows green.

9. Insert an EZFlyer ™ 230MB cartridge into the drive.
The drive will begin to spin up the cartridge, and the Activity LED will 
flicker. The Activity LED will glow steadily green when the drive is 
ready. See “Inserting the Cartridge” on page 10 for details.
6 EZFlyer 230 MB Removable Cartridge Hard Drive



                                         
Installing SyQuest ® Software
After connecting your EZFlyer™  drive to your computer, you need to install 
SyQuest® software in order to use your drive. The DOS, Windows 3.1, and 
Windows 95 installations include the SyQuest® drivers and the SyQuest® 
Utility software. The OS/2 and Windows NT installations include the 
SyQuest® drivers only.

DOS/Windows Users:
1. Exit Windows to DOS. 

Press Alt + F4 to exit out of Windows; do not use a DOS shell.

2. Insert SyQuest ® Installation Diskette-3  into your 
diskette drive.

3. At a DOS prompt, type: A:INSTALL and press Enter.
If B:  is your 3.5-inch diskette drive, type B:INSTALL  and press Enter.

Windows 95 Users: 
1. Click Start , then click Settings  and click Control Panel .

2. In the Control Panel Window, double-click the 
Add/Remove Programs icon. 

3. Insert  SyQuest Installation Diskette-2  into the diskette 
drive and click Install. 

4. Click Next, then click Finish  once. 

5. Follow the instructions in the window at the bottom of 
the screen to install the SyQuest ® driver
You may need to rearrange the program windows to view all windows.

6. Follow the instructions in the Installation Wizard 
window to complete the software installation.
Installation Guide for PC Compatible Systems 7



OS/2 Users:
1. Insert SyQuest ® Installation Diskette-1  into your 

diskette drive. 

2. Select Device Driver Install  from System Setup. 

3. Change the source from A:\ to  A:\OS2  and click Install .
If B:  is your 3.5-inch diskette drive, change the source from B:\ to 

B:\OS2.

4. Click SyQuest Parallel Port Device  and click OK.

Windows NT Users: 
1. Insert SyQuest ® Installation Diskette-1 into your 

diskette drive.

2. Double-click the Windows NT Setup icon in the Main 
program group.
The Options menu displays.

3. Select Add/Remove SCSI Adapters  and click Add .

4. Scroll to the bottom of the Add menu and select Other.

5. Enter A:\WINNT\ and select SyQuest EPATHD Parallel to 
ATA Adapter .
If B:  is your 3.5-inch diskette drive, change the source from B:\ to 

B:\WINNT\.

6. Allow the Installation program complete its operations.

7. Restart your computer.
You will be able to use your EZFlyer™  drive when your computer 
restarts.
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Note: Printer Pass-through is not supported in Windows NT.
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Inserting the Cartridge
The EZFlyer™  drive reads, writes, and formats SyQuest® 135 MB and 230 MB 
cartridges. The EZFlyer™  drive cannot read, write, or format other SyQuest® 
cartridges.

1. Hold the cartridge as shown in the figure below.

2. Open the drive door with the cartridge corner.

Note: You can insert SyQuest® cartridges with the drive power on or off.

3. Slide the cartridge into the drive until it stops.

4. Push the cartridge down until it locks into the drive.
The drive will begin to spin up the cartridge, and the Activity LED will 
flicker. The Activity LED will glow steadily green when the drive is 
ready.

®
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Caution: If you drop your EZFlyer™  drive, Do not insert a cartridge or test 
your drive to see if it was damaged by the drop. Contact your SyQuest® 
reseller for instructions.
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Removing the Cartridge
Follow these steps to remove the cartridge when changing cartridges or 

transporting your EZFlyer™ drive.

1. Verify that the Power LED glows green.
The EZFlyer™  should always be switched on when you eject a cartridge.

2. Exit out of all applications that use the cartridge and 
close all open files on the cartridge.
You may lose data if you eject the cartridge before closing all open files 
on the cartridge.

3. Unlock the cartridge.

DOS Users: Type UNLOCK at a DOS prompt.

Windows 3.1 Users: Double-click the SyQuest® Unlock Utility icon, 
select the EZFlyer™ drive letter and click Ok.

Windows 95 Users: Windows 95 automatically locks and unlocks the 
cartridge. You do not need to manually unlock the cartridge to remove 
the cartridge.

OS/2 Users: Select the EZFlyer™  drive icon, click the right mouse 
button, and select the Unlock menu item.

4. Press the Eject button on the front of the EZFlyer ™  
drive.
The Drive Activity LED will flicker, the drive door will open, and the 
cartridge will pop out of the drive after a few seconds. If the Drive 
Activity LED does not flicker, unmount the cartridge using the SyQuest® 
Windows 95 Utility, or use the SyQuest® Unlock utility in Windows 3.1.
12 EZFlyer 230 MB Removable Cartridge Hard Drive



5. Remove the cartridge and place it in its case.
Always store the cartridge in its protective case with the cardboard 
sleeve on.

Note: Your protective case may not look exactly like the example shown 
here.

Caution: Never store or transport the EZFlyer™  with the cartridge partially 
inserted. Leaving a cartridge partially inserted, or transporting the EZFlyer™ 

 with the cartridge inserted may damage the EZFlyer™  drive and void your 
warranty.

230MB
TMTM

R EM O VA B L E  C A R T R I D G E  H A R D  D R I V E

ezflyer

®
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REMOVABLE CARTRIDGE HARD DRIVE
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Case
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Ejecting the Cartridge without Power
In the event of a power failure, you can remove the cartridge using the 
manual eject hole. 

1. Wait at least one minute after the power fails before you 
perform this procedure.

2. Locate the manual eject hole on the bottom of the 
drive.
The manual eject hole is a small round hole on the bottom of the 
EZFlyer™  drive.

3. Insert a straightened paper clip into the manual eject 
hole on the bottom of the drive.
The cartridge will eject part way. Be careful not to hold the EZFlyer™  
drive with the drive door facing down; the cartridge may fall out of the 
drive and be damaged.

4. Remove the cartridge and place it in its case.
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Write-protecting the Cartridge
You can use the EZFlyer™  drive’s write-protect software (part of the 
SyQuest® Utilities) to prevent data on the cartridge from being altered or 
erased. You can use SyQuest® Utilities under DOS, Windows 3.1, and 
Windows 95. 

Caution: The hardware write-protect switch on 135 MB cartridges does 
not write-protect the cartridge in the EZFlyer™  drive. The write-protect 
feature of the EZFlyer™  drive is controlled by software utilities only, 
regardless of any hardware write-protect settings.

SyQuest® cartridges ship from the factory ready to record data. To write-
protect a cartridge:

1. Verify that a cartridge is in the drive and the Drive 
Activity LED glows green.

2. Run the SyQuest ® utility software
You installed the SyQuest® utilities in “Installing SyQuest® Software” on 
page 7.

DOS Users: Run the SQSHELL program and select Options. Select 
either:

• Enable Write Protect Utility
Data on the cartridge cannot be altered or erased.

or

• Disable Write Protect Utility
Data on the cartridge can be edited or erased.

Windows 3.1 Users: Run the SyQuest® Utilities and click the Control 
button. Click the EZFlyer™  drive letter button and click the Set to ON 
button in the Write Protect box. To disable the write-protect feature, 
Select the drive letter button in the list box and click the Reset to OFF 
button in the Write Protect box.
Installation Guide for PC Compatible Systems 15



Windows 95 Users:  Run the SyQuest® Win95 Utility and click the 
Control button. Select the letter of the EZFlyer™  drive in the list box and 
click the Set to ON button in the Write Protect box. To disable the write-
protect feature, Select the drive letter in the list box and click the Reset to 
OFF button in the Write Protect box.

Note: Write-protection is not supported under Windows NT or OS/2.
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A

Upgrading EZ135 Drives
If you are currently using an EZ135 parallel port drive on your system 
and you want to install an EZFlyer™  parallel port drive on the same 
system, follow this procedure before you install your EZFlyer™  drive. 
The diskettes included with your EZFlyer™  drive update your EZ135 
drive and install new software for both EZ135 EPP and EZFlyer™  EPP 
parallel port drives.

You may run either the EZ135 drive or the EZFlyer™  drive (but not both 
at the same time) on your system once you complete this procedure.

To update your EZ135 drive:

1. Update the EZ135 Drive Hardware 
DOS, Windows 3.1 and Windows 95 users should all perform this 
step.
13



                                                  
a. Verify that only  the EZ135 drive is connected to your 
computer’s parallel port, and that the EZ135 drive is switched 
on. 
Make sure to disconnect any parallel port printers or other parallel 
port devices before you continue.

Caution: You may damage your printer or parallel port device if you do 
not disconnect it from your computer before performing this procedure.

b. Insert SyQuest Installation Diskette-1  into your diskette drive.
Use SyQuest Installation Diskette-1 that came with your new 
EZFlyer™  drive, not the diskette that came with your EZ135 drive.

c. Run the hardware update program named SET135L.

DOS Users: At a DOS prompt, type A:SET135L and press Enter.

Windows 3.1 Users: From the File menu in Program Manager select 
RUN, type A:SET135L , and press Enter. Once the SET135L program 
finishes, your EZ135 hardware update is complete. Go to step 3 on 
page 15.

Windows 95 Users: From the Start button, select RUN, type 
A:SET135L , and press Enter. Once the SET135L program finishes, 
proceed to step 2 on page 14. 

Note: If your 3.5-inch diskette drive is drive B: , replace A:  in the 
commands in step c above with B: .

2. Remove the existing Windows 95 EPP Driver 
Only Windows 95 users should complete this step.
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a. Click Start , click Settings , and click Control Panel .

b. From the Control Panel  window, double-click the System  icon.

c. Click the Device Manager  tab.

d. Double-click SCSI controllers .

e. Click the SyQuest Parallel Port Device  entry to select the old 
driver.

f. Click Remove .
Windows 95 will prompt you for verification of the device removal; 
click OK to confirm.

Note: If there are more than one SyQuest Parallel Port Device entries, 
select each one and click Remove.

g. Click Close  to close the Control Panel.

h. Shut down your system and then disconnect the EZ135 EPP 
drive.

3. Follow the installation instructions starting on page 1 
to install your EZFlyer ™  drive.
DOS, Windows 3.1 and Windows 95 users should complete this step.

After you complete the EZFlyer™  Installation Guide procedure, you 
can use either your EZ135 drive or your EZFlyer™  drive with your 
computer. 

Note: You cannot use both drives simultaneously by daisy chaining the 
parallel port drives.
Installation Guide 15
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